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Introduction 

The Nonpoint Source Pollution and Erosion Comparison Tool (N-SPECT) examines the 
relationship between land cover, nonpoint source pollution, and erosion.  N-SPECT is an 
extension to Environmental Systems Research Institute’s (ESRI) ArcGIS software package, 
version 8.x, and requires ESRI’s Spatial Analyst extension.  N-SPECT is designed for use with 
any watershed, provided the user has access to the necessary data.  This user’s manual provides 
a detailed description of the interfaces within N-SPECT and the data required to perform an 
analysis.  The technical guide explains in more detail where the data that are distributed with N-
SPECT were acquired and how the data were processed to be compatible with N-SPECT. 

 

N-SPECT uses spatial elevation data to calculate flow direction and flow accumulation throughout 
a watershed.  To do this, land cover, soils, and precipitation data sets are processed to estimate 
runoff volume at both the local and watershed levels.  Coefficients representing the contribution of 
each land cover class to the expected pollutant load are also applied to land cover data sets to 
approximate total pollutant loads. These coefficients were derived from a combination of relevant 
studies and local water quality sampling data or taken from published sources.  The output layers 
display estimations of runoff, pollutant loads, pollutant concentration, and total sediment loads.  
These layers can help resource managers make informed decisions about water quality and what 
areas to target for improvement, as well as predict the impacts of management decisions on 
water quality.  N-SPECT also provides functionality to compare current land cover conditions to 
proposed changes in both land use and land cover. 
 
 
Note: Data provided with N-SPECT are for the Wai’anae area, located on the western side of 
O’ahu, Hawai’i.  The Technical Guide explains in more detail where the data were acquired for 
the Wai’anae study area and how the data were processed to be compatible with N-SPECT.
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1. Getting Started 
 

1.1 Installing N-SPECT 

Run the setup by double-clicking on the file, setup.exe.  
 
Note: If a previous version of N-SPECT is already installed, it should be removed prior to 
installing a new version.  To uninstall the previous version, use the function Add/Remove 
Programs in the Control Panel, select N-SPECT, and click Change/Remove.  Then follow the 
instructions from the wizard to uninstall the tool.  Check the location where N-SPECT was 
installed and make sure it is empty (the directory will not be deleted). 
 
After double-clicking the setup, follow the instructions to complete the setup and an “NSPECT” 
directory will be installed on your C:/ drive. 
 
 

 
 
 
1.2 Loading N-SPECT  

• Open ArcMap and create a new empty map or open the desired ArcMap project.   
 

• Right click on the menu bar to reveal the context menu showing available tools.  Check 
the box next to N-SPECT to turn it on.   

 
Note: The toolbars can also be accessed under View, Toolbars.  Put a check by N-SPECT.  If the 
N-SPECT menu does not appear in the list, click on “Customize” and complete the following 
steps: 

• In the Customize dialog that appears, click on the “Add from file” button. 
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• Navigate to NSPECT.dll (installed by default under C:\NSPECT), and click on “Open” to 
select the file. 

 
• A dialog box will appear informing you that the tool has been added to ArcMap.   

Click “OK”. 
 
• Click on the “Close” button.  You should now see the N-SPECT toolbar added to ArcMap. 

 
The main N-SPECT menu is shown below.  

 
 
 
Note: It is not necessary to activate the Spatial Analyst Extension because it will be automatically 
activated when N-SPECT is loaded.  To verify that it has been activated, click Tools, Extensions.  
The Spatial Analyst extension will be checked when N-SPECT is in use.  
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2. Running an Analysis 

2.1 Setting Up a Project 

Use the Run Analysis option on the main N-SPECT menu to 
define all parameters required to perform an analysis within a 
defined region.   

Use the File menu to create a new project or open an existing 
project file.  Use the Pollutants tab to define which pollutants to 
include in the assessment.  Use the Erosion, Land Uses, and 
Management Scenarios tabs to specify optional parameters to 
consider in the analysis. 

 

 

 

 

 

A 
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(A) Project Information: 

• Name: To save the parameters in a project file, designate a name for the project when a 
new project is created or an existing project is modified.  The parameters that are used in 
each analysis are saved in this project file, which is in .xml format.  Be sure to save the 
project under a new name each time you make changes, or the original project 
parameters will be lost. 

• Working Directory: Designate a working directory for your project.  The working 
directory will default to C:\NSPECT\workspace. 

(B) Land Cover: 

• Grid: Select the land cover grid that will be used in the analysis.  The field contains a 
drop-down list of all grids loaded in the ArcMap project. 

• Grid Units: Select the units (meters or feet) for the selected land cover grid. 

• Type: Select the land cover type that matches the selected land cover grid.  The drop-
down list contains all currently defined land cover types (see Advanced Settings, Land 
Cover to learn how to add a land cover type). 

(C) Soils: 

• Soils Definition: Select the soils configuration that will be used in the analysis.  The 
drop-down list contains all currently defined soil configurations.  The soils configuration 
specifies the grid that contains spatial values for the hydrologic soil types in the area of 
interest and the grid that contains spatial values for the K factor (soil erodibility factor) in 
the area of interest (see Advanced Settings, Soils to learn how to add a soil 
configuration). 

• Hydrologic Soils Data Set: This shows the hydrologic soil type (A, B, C, or D, 
depending on the soil’s infiltration rates) grid associated with the soils configuration 
selected in the Soils Definition drop-down field. 

(D) Miscellaneous: 

• Selected Polygons Only: Select this check box to perform the analysis on a selected 
area.  The analysis will be performed in the entire watershed (or catchment basin) in 
which the polygon is located, but the output will be clipped to the selected area.  This 
option is only active if a polygon data layer is loaded in the ArcMap project. 

• Local Effects Only: Select this check box to remove the influence of upstream cells from 
the analysis.  Local Effects will only account for the runoff, pollutants, and sediment yield 
generated at each cell, rather than incorporating the cumulative effects of upstream cells 
in the watershed. 

(E) Precipitation Scenario: Select the precipitation scenario to be used in the analysis from the 
drop-down list of all currently defined precipitation scenarios or define a new precipitation 
scenario (see Advanced Settings, Precipitation Scenarios to learn how to add a precipitation 
scenario). 

(F) Watershed Delineation: Select the watershed delineation data to be used in the analysis 
from the drop-down list of all currently defined watershed delineations or define a new watershed 
delineation (see Advanced Settings, Watershed Delineations to learn how to add a watershed 
delineation).  These water quality standards can be acquired from state and local water quality 
regulatory agencies. 
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(G) Water Quality Standard: Select the water quality standard to be used in the analysis from 
the drop-down list of all currently defined water quality standards or define a new water quality 
standard (see Advanced Settings, Water Quality Standards to learn how to add a water quality 
standard). 

 
(H) File Menu: Use the File menu to create a new project, to open a previously defined project, or 
to save a new or modified project.  Select New Project to start a new analysis.  Select Open 
Project to open an existing project file.  Fields in the project setup window will be automatically 
filled with the information that was previously saved.  Choose Save or Save As to save the 
current project.   
 

 

 

2.2 Estimating Pollutant Loads 

Use the Pollutants tab to define which pollutants to include and which coefficient set to apply in 
the analysis.  All the pollutants in the database with defined coefficient sets are listed in the table. 
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Apply: To include a pollutant in the analysis, select the check box in the Apply column.  To 
exclude a pollutant from the analysis, clear the check box.  The column defaults to cleared, which 
means that the pollutant in that row will not be included in the analysis. 

Pollutant Name: The Pollutant Name column is automatically populated with the name of all the 
currently defined pollutants and cannot be edited in this window (see Advanced Settings, 
Pollutants to learn how to add a pollutant).  

Coefficient Set: Select the appropriate coefficient set for the pollutant from the drop-down list of 
all currently defined coefficient sets for that pollutant (see Advanced Settings, Coefficients to 
learn how to add a coefficient set). 

Which Coefficient: Select the coefficient type (Type 1, Type 2, Type 3, or Type 4) to be used to 
run the analysis.    N-SPECT will apply that coefficient type to each land cover class in the area of 
interest.  If only one type of coefficient is available, select Type 1. 

 
Once the pollutants are specified and the other parameters in the project setup window are 
selected, the analysis can be run by pressing the Run button in the bottom right-hand corner of 
the window.  Erosion will not be included in the analysis unless the Calculate Erosion option is 
activated on the Erosion tab (see next section). 
 

2.3 Estimating Sediment Loads (optional) 

Use the Erosion tab to indicate whether or not you want N-SPECT to calculate erosion.  The 
content of the erosion tab will change based on whether an event-based precipitation scenario or 
an annual precipitation scenario is selected in the Precipitation Scenario field. 

Event Type Precipitation Scenario: To include erosion calculations in the analysis, select the 
check box beside Calculate Erosion for Event Type Precipitation Scenario.   

 

K Factor Data Set: This shows the K factor grid associated with the soils configuration 
selected in the Soils Definition drop-down list.  The K factor is an erodibility factor needed to 
estimate soil loss.  The erodibility factor is based on soil characteristics and can be acquired 
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from the Natural Resources Conservation Services (NRCS) Soil Survey Geographic 
(SSURGO) database. 

 

Annual Type Precipitation Scenario: To include erosion calculations in the analysis, select the 
check box beside Calculate Erosion for Annual Type Precipitation Scenario. 

 

• K Factor Data Set: This shows the K factor grid associated with the soils configuration 
selected in the Soils Definition drop-down list.  The K factor is an erodibility factor needed 
to estimate soil loss.  The erodibility factor is based on soil characteristics and can be 
acquired from the NRCS SSURGO database. 

• Rainfall Factor: The Rainfall Factor frame becomes available if the selected precipitation 
scenario is an annual precipitation scenario.  The rainfall factor (also called the runoff 
erosivity factor) quantifies the effects of raindrop impacts and reflects the amount and 
rate of runoff associated with the rain.  Rainfall factors can also be acquired from the 
NRCS SSURGO data set.  To use a grid, check Use GRID and select the appropriate 
grid from the drop-down list of grids loaded in the ArcMap project.  To use a constant 
value, check Use Constant Value and enter a valid numeric value greater than zero.  This 
constant rainfall factor value will be applied for the entire study area. 

 

2.4 Incorporating Scenarios 

2.4.1 Land Uses 

 
Use the Land Uses tab to define a specific land use and new coefficient set in a particular area.  
N-SPECT will use this new land use coefficient set to calculate pollutant loads in this area.  The 
original land cover grid values will be ignored in the calculation.  For example, if a known area is a 
landfill, a new land use type “landfill” can be defined with appropriate coefficients that are applied 
only to that area.  
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Note: When both a land use scenario and a management scenario (see next section) are 
selected for the same area, the management scenario will be performed first.  The final result in 
the overlapping area will reflect the land use scenario that was specified.  
 

 

• Apply: To include a land use scenario in the analysis, select the check box in the Apply 
column.  To exclude the land use scenario from the analysis, clear the check box.  The 
column defaults to cleared, which means that the land use scenario in that row will not be 
included in the analysis. 

• Land Use Scenario: The Land Use Scenario column on the Land Uses tab displays all 
the land use scenarios that have been defined for the current project.  Add, edit, or delet e 
a scenario by right-clicking within the table. 

Add Land Use Scenario 

A new scenario can be added to N-SPECT by right-clicking in the table on the Land Uses tab 
and selecting Add Scenario from the drop-down list.   
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• Scenario: Provide a name for the new scenario being added (limit of 35 characters). 

• Layer: Select the polygon layer that delineates the area of your land use.  The drop-
down list contains all defined polygon layers in the ArcMap project.  The new land use 
type will be applied to the entire selected layer.   

Note: When both a land use scenario and a management scenario are selected for the 
same area, the management scenario will be performed first.   

• SCS Curve Numbers: Designate Soil Conservation Service (SCS) curve numbers for 
the new land use type for each soil type (A, B, C, and D).  The SCS curve numbers 
represent the infiltration of precipitation into the soil and are used when calculating runoff 
and erosion.  The water that infiltrates is not included in the flow accumulation 
calculations; therefore, a more accurate prediction of the total runoff is provided.  SCS 
curve numbers are percentages entered into N-SPECT in decimal form as numbers 
between 0 and 1; the higher the curve number, the greater the amount of runoff.  The 
four columns, A, B, C, and D, represent the curve numbers for each of the four hydrologic 
soil types, which indicate the soil’s minimum infiltration rate.  Group A soils (typically sand 
or gravel) have the highest infiltration potential, and Group D soils (typically clay soils) 
have the lowest infiltration potential.  Group B soils (typically silt with fine to moderately 
course textures) have a moderate infiltration rate, and Group C soils (typically sandy clay 
with a moderately fine to fine texture) have a low infiltration rate. 

• Cover Factor: Specify a cover factor for the new land use type.  The cover factor is 
defined as the ratio of soil loss from land under specified vegetative or mulch conditions 
to the corresponding loss from tilled, bare soil.  More dense cover slows water and 
prevents it from flowing down a slope, quickly carrying sediment.  The lower the cover 
factor, the better the vegetative cover is at preventing erosion.  The higher the cover 
factor, the more erosion will result in that area.  For example, grasslands generally have 
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a much lower cover factor than bare land because the vegetation will help prevent soil 
erosion. 

• Water/Wetlands: Select the Water/Wetlands check box if the land use type is water or a 
wetland.  This information is required to accurately calculate erosion. 

• Pollutant: Each pollutant that the user has defined within N-SPECT will be listed in the 
pollutant column.  This column is cannot be edited. 

• Coefficients: Specify a coefficient for each pollutant that may result from this land use 
type.  Only one type of coefficient must be specified.  The Type 2, Type 3, and Type 4 
columns can be used in cases where some phenomenon will cause the coefficients for 
each pollutant to change. 

 

2.4.2 Management Scenarios 
 
Use the Management Scenarios tab to change the land cover within a specified region to a 
different land cover class that is already defined in the land cover classification being used in the 
analysis.  For example, to estimate the impact of a new housing development, you can create a 
polygon shapefile of the area that will be developed and apply the high- or low-intensity 
developed land cover class to that specific area.  The coefficients for the newly designated land 
cover class will be used in these designated areas rather than the coefficients for the original land 
cover data set.   
 
Note: The original land cover data set will not be changed, but original coefficients will be ignored.  
When both a land use scenario and a management scenario are selected for the same area, the 
management scenario will be performed first.  The final result in the overlapping area will reflect 
the land use scenario that was specified.  
 

 
 

• Apply: To include a management scenario in the analysis, select the check box in the 
Apply column.  To exclude the management scenario from the analysis, clear the check 
box.  The column defaults to cleared, which means that the management scenario in that 
row will not be included in the analysis. 
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• Change Area Layer: Select the polygon layer that will be changed to a different land 
cover class.  The Change Area Layer drop-down list contains all defined polygon layers 
in the ArcMap project. 

• Change to Class: Select the new land cover class that will be applied to the polygon 
layer.  The Change to Class drop-down list contains all land cover classes for the 
selected land cover type. 

 

 

 

Add Management Scenario 

There are three options, available via a pop-up menu, to edit the management scenario 
parameters.  Access the pop-up menu by right-clicking within the table. 

 
• Append Row: Add a new management scenario to the end of the table by selecting 

Append Row from the pop-up menu that displays by right-clicking within the table.  In the 
Change Area Layer column, select the polygon layer denoting the area where the land 
cover class will change.  The column contains a drop-down list of all polygon layers 
defined in the active data frame.  Then select the new land cover class for the region. 

 
• Insert Row: Insert a new management scenario into the table by selecting Insert Row 

from the pop-up menu that displays by right-clicking within the table.  In the Change Area 
Layer column, select a polygon layer denoting the area where the land cover class will 
change.  The column contains a drop-down list of all polygon layers defined in the active 
data frame.  Then select the new land cover class for the region. 

 
• Delete Row: Delete an existing management scenario by clicking on the appropriate row 

and selecting Delete Row from the pop-up menu that displays by right-clicking within the 
table.  Confirm the choice to delete when prompted and the selected management 
scenario and its associated information will be deleted from the database.
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3. Advanced Settings 
 
The Advanced Settings menu provides access to functionality for viewing, editing, and adding 
region-specific data sets and parameters.  Default data sets and parameters are defined for the 
Wai'anae region and have been provided with N-SPECT.  Users in the Wai'anae area that 
choose to use the default data can skip the Advanced Settings section and go directly to the Run 
Analysis menu selection.  Users that want to use N-SPECT in other regions nationwide can use 
the advanced settings to incorporate data from their local area. 
 

3.1 Land Cover 

Land cover data is the basis of N-SPECT’s functionality.  Land cover is used to estimate pollutant 
loads by applying coefficients for individual pollutants to each land cover class.  N-SPECT was 
designed using C-CAP (Coastal Change Analysis Program) land cover data; however, any land 
cover data can be used in the tool provided the appropriate pollutant coefficients have been 
defined.  

Use the Land Cover Types window to select the land cover type to be viewed or edited.  All 
currently defined land cover types are available via the Land Cover Type drop-down list.  When a 
land cover type is selected, the remaining fields are automatically populated with information 
about the selected land cover type. Use the Options menu to create, import, delete, or export a 
land cover type. 
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Land Cover Type: Use this to designate the land cover type.  The box drop-down list contains all 
currently defined land cover types within N-SPECT.  

Description: A brief description of the selected land cover type.  Provide a description (less than 
100 characters) when importing or creating a new land cover type data set. 

Classification: This column contains the grid value and corresponding name for each land cover 
class in the currently selected land cover type.  Provide values and names when creating a new 
land cover data set. 

SCS Curve Numbers: The Soil Conservation Service (SCS) curve numbers represent the 
infiltration of precipitation into the soil.  The water that infiltrates is not included in the flow 
accumulation calculations; therefore, a more accurate prediction of the total runoff is provided. 
SCS curve numbers are percentages entered into N-SPECT in decimal form as numbers 
between 0 and 1; the higher the curve number, the greater the amount of runoff.  The four 
columns, CN-A, CN-B, CN-C, and CN-D, represent the curve numbers for each of the four 
hydrologic soil types, which indicate the soil’s minimum infiltration rate.  Group A soils (typically 
sand or gravel) have the highest infiltration potential, and Group D soils (typically clay soils) have 
the lowest infiltration potential.  Group B soils (typically silt with fine to moderately course 
textures) have a moderate infiltration rate, and Group C soils (typically sandy clay with a 
moderately fine to fine texture) have a low infiltration rate.  For instances where a dual hydrologic 
group is assigned (e.g., A/D, B/D, C/D), the highest curve number of the two components is used 
(see the N-SPECT technical guide for a detailed description).  Default values for C-CAP land 
cover data are provided with N-SPECT.  Provide SCS curve number values when creating a new 
land cover data set. 

 
Hydrologic Soil Group Definitions 

Hydrologic Soil 

Group 
Soil Group Characteristics 

A 
Soils having high infiltration rates, even when thoroughly wetted, and 
consisting chiefly of deep, well-drained to excessively drained sands 
or gravels.  These soils have a high rate of water transmission. 

B 

Soils having moderate infiltration rates when thoroughly wetted and 
consisting chiefly of moderately deep to deep and moderately fine to 
moderately coarse textures.  These soils have a moderate rate of 
water transmission. 

C 

Soils having slow infiltration rates when thoroughly wetted and 
consisting chiefly of soils with a layer that impedes downward 
movement of water, or soils with moderately fine to fine texture.  
These soils have a slow rate of water transmission. 

D 

Soils having very slow infiltration rates when thoroughly wetted and 
consisting chiefly of clay soils with a high swelling potential, soils with 
a permanent high water table, soils with a claypan or clay layer at or 
near the surface, and shallow soils over nearly impervious material.  
These soils have a very slow rate of water transmission. 

 

RUSLE: The Cover Factor and Wet columns are values used in the Revised Universal Soil Loss 
Equation (RUSLE) to calculate erosion.  The cover factor is typically a number between 0 and 1, 
and is essentially the ratio of soil loss from land under specified vegetative conditions to the 
corresponding loss from bare soil.  The cover factor reduces the soil loss estimate according to 
the effectiveness of vegetation at preventing detachment and transport of soil particles.  The 
higher the value, the more erosion occurs (e.g., bare land has a relatively high cover factor).  
Default values for C-CAP data are provided with N-SPECT.  Provide cover factor values when 
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creating a new land cover data set.  The Wet column designates whether the land cover type is 
water or wetland.  If the land cover class is water or wetland, the check box in this column should 
be selected.  For any non-water class, the check box should be cleared.  This distinction is 
necessary for an accurate calculation of erosion.  

 

Add Land Cover Type 

To create a new land cover type, select New from the Options menu.   

 

 

 

 

Land Cover Type: Provide a name for the new land cover type being added (limit of 35 
characters).   

Description: Provide a brief description (less than 100 characters) of the new coefficient set. 
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Classification: Input the grid value (Value column) and corresponding name (Name column) for 
each land cover class in the new land cover type.  To add, insert, or delete a row, right-click in the 
table. 

SCS Curve Numbers: Specify the Soil Conservation Service (SCS) curve numbers in the CN-A, 
CN-B, CN-C, and CN-D columns.  Curve numbers represent the infiltration of precipitation into 
the soil.  The four columns represent the curve numbers for each of the four hydrologic soil types, 
which indicate the soil’s minimum infiltration rate.  The water that infiltrates is not included in the 
flow accumulation calculations; therefore, a more accurate prediction of the total run-off is 
provided.  SCS curve numbers are percentages entered into N-SPECT in decimal form as 
numbers between 0 and 1; the higher the curve number, the greater the amount of runoff.   

Group A soils (typically sand or gravel) have the highest infiltration potential and Group D soils 
(typically clay soils) have the lowest infiltration potential.  Group B soils (typically silt with fine to 
moderately course textures) have a moderate infiltration rate, and Group C soils (typically sandy 
clay with a moderately fine to fine texture) have a low infiltration rate.  For instances where a dual 
hydrologic group is assigned (e.g., A/D, B/D, C/D), the highest curve number of the two 
components is used. 

RUSLE: Specify the cover factor for each land cover type.  The cover factor is typically a number 
between 0 and 1, and is essentially the ratio of soil loss from land under specified vegetative 
conditions to the corresponding loss from bare soil.  The cover factor reduces the soil loss 
estimate according to the effectiveness of vegetation at preventing detachment and transport of 
soil particles.  The higher the value, the more erosion occurs (e.g., bare land has a relatively high 
cover factor). 

Specify whether the land cover type is water or wetland in the Wet column.  If the land cover 
class is water or wetland, the box in this column should be checked.  For any non-water class, the 
box should be left unchecked.  This distinction is necessary for an accurate calculation of erosion. 

Delete Land Cover Type 

 

To delete an existing land cover type, select the land cover type to be deleted from the Land 
Cover Type drop-down list and choose Delete from the Options menu.  The selected land cover 
type and all associated coefficient sets will be deleted from N-SPECT’s database and will no 
longer appear in the Land Cover Type drop-down list.  

Note: The C-CAP land cover type cannot be deleted. 

 

Import Land Cover Type 
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The import function will allow you to use land cover data sets from other N-SPECT users without 
entering them by hand.  Other users can use the export function to save the land cover, curve 
numbers, and cover factor in the appropriate format.  To import a land cover type, select Import 
from the Options menu.  Name the file and navigate to the folder in which it is located.  The 
imported file must be an ASCII file containing a header row, followed by a row of comma-
separated values for each land cover class.  The header row should contain the name of the land 
cover type and a description, separated by a comma (no space).  Each row must contain seven 
fields ordered as follows: Value,name,Curve#-A,Curve#-B,Curve#-C,Curve#-D,CoverFactor,Wet. 
Supply a name for the new land cover type when it is imported.  The new land cover type will be 
added to the Land Cover Type drop-down list. 

 

 

Export Land Cover Type  
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The export function will allow you to share land cover data sets with other N-SPECT users, who 
can use the import function to load the land cover, curve numbers, and cover factor without 
entering the values by hand.  To export a land cover type, select the land cover type to be 
exported from the Land Cover Type drop-down list and choose Export from the Options menu.  
Name the exported file and designate a location in which to save the file.  The land cover classes 
are written to a comma-separated ASCII file containing a row of values for each land cover class.  
The file contains a header row with the name of the land cover type and the description.  Each 
row contains seven fields ordered as follows: Value,name,Curve#-A,Curve#-B,Curve#-C,Curve#-
D,CoverFactor,Wet. 

 
3.2 Pollutants 

The primary focus of N-SPECT is nonpoint source pollutants.  N-SPECT applies coefficients 
representing the expected pollutant load from each land cover type to approximate total nonpoint 
source pollutant loads.  The coefficients included with N-SPECT should be considered specific to 
the Wai’anae area of O’ahu, Hawai’i.  They were derived using local water quality and land cover 
data when available.  When local data were not available, coefficients were derived from data or 
studies in other areas of Hawai’i, or, if necessary, from published studies in other areas.  The 
accuracy of N-SPECT results depends on these coefficients.  To apply the tool to other areas, 
you should develop coefficients based on local data when possible.  A discussion of how pollutant 
coefficients were derived for the Wai’anae area is included in the technical guide distributed 
electronically with N-SPECT. 

Use the Pollutants dialog box to view or edit information about previously defined pollutants, to 
define new pollutants, or to delete pollutants that are no longer needed.  Use the Pollutants menu 
to add or delete a pollutant.  Use the Coefficients menu to create, copy, delete, import, or export a 
coefficient set.  

 

View or Modify Pollutant 

To modify an existing pollutant, select Advanced Settings and Pollutants.  Select the pollutant of 
interest in the Pollutant Name drop-down list.  The list will display all the currently defined 
pollutants within N-SPECT.  Fields in the Pollutants window are populated according to the 
selected pollutant.  Use the Coefficients tab to view or edit information about the defined 
coefficient sets for the selected pollutant. 
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Add Pollutant 

To add a new pollutant, select Add from the Pollutants menu.   
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Pr 

Pollutant Name: Provide a name for the new pollutant being added (limit of 35 characters). 

Coefficient Set: Provide a name for the coefficient set to associate with the new pollutant. 

Land Cover Type: Select the type of land cover that will be used to define new coefficients for 
the pollutant being added.   

Description: Provide a brief description (less than 100 characters) of the new coefficient set. 

Class: The Value and Name columns contain the grid value and corresponding name for each 
land cover class defined for the associated land cover type.  These values cannot be edited.  

Coefficients: Enter coefficients into the table for each land cover class.  Only one type of 
coefficient is required, so only one column must be completed, but the functionality to enter four 
different types of coefficients is available.  The coefficients give the average concentration of the 
selected pollutant that is released by the identified land cover during a precipitation event.  This is 
frequently referred to as the Event Mean Concentration.  To learn how to derive local coefficients 
for an area of interest, see the N-SPECT technical guide. 

Delete Pollutant  

To delete an existing pollutant, select the desired pollutant for deletion and select Delete from the 
Pollutants menu. 
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Confirm the choice to delete when prompted.  The pollutant, all associated coefficient sets, and 
all references to the pollutant in water quality criteria will be deleted from the database. 

 

3.3 Coefficients 

Coefficients give the average concentration of the selected pollutant that is released by the 
identified land cover during a precipitation event.  This is frequently referred to as the Event Mean 
Concentration.  To learn how to derive local coefficients for an area of interest, see the N-SPECT 
technical guide. 

 

 

Add New Coefficient Set 

To create a new coefficient set, select the pollutant for which you want to create a new coefficient 
set in the Pollutant drop-down field and select New Set from the Coefficients menu.  Designate a 
Coefficient Set Name and associate a land cover type in the Land Cover Type field.  Click OK 
and a new coefficient set will be created, with the values defaulting to zero.  Enter a description of 
the coefficient set.  Enter a coefficient for each land cover class defined for the land cover type.  
Values must be entered for at least one of the four types (Types 1 through4).   
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Copy Coefficient Set 

To copy a coefficient set, select Copy Set from the Coefficient menu.  Designate a coefficient set 
to copy from and a new coefficient set name.  The Copy from Coefficient Set drop-down menu 
will contain all defined coefficient sets for the selected pollutant.  Click OK and a new coefficient 
set will be created that is identical to the coefficient set selected in the Copy from Coefficient Set 
field.  The coefficient values may be edited for the new set. 

 

Delete Coefficient Set 

To delete an existing coefficient set, select the desired coefficient set for deletion and select 
Delete Set from the Coefficient menu.  Confirm the choice to delete when prompted.  The 
selected coefficient set will be deleted from the database. 

Import Coefficient Set 

 

To import a coefficient set, select Import Set from the Coefficients menu.  Specify a name for the 
coefficient set to be imported and the land cover type that will be associated with it.  Browse for 
the coefficient set file that contains the values to be imported.  The file must contain a header row 
with the name of the land cover type and a description, separated by a comma (no space).  The 
imported file must be an ASCII file containing a row of comma-separated values for each land 
cover class.  Each row must contain five fields ordered as follows: Value,Type 1,Type 2,Type 
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3,Type 4.  The new coefficient set will be added to the Coefficient Set drop-down list.  The 
associated land cover type should match the land cover values defined within the import file.  The 
new coefficient set will be added to the Coefficient Set drop-down list. 

 

 

Export Set 

To export a coefficient set, select Export Set from the Coefficients menu.  Name the file and 
designate a location to save it.  The coefficient set will be written to a comma-separated ASCII file 
containing a row of values for each land cover class.  Each row will contain five fields ordered as 
follows: Value,Type 1,Type 2,Type 3,Type 4. 

 

3.4 Water Quality Standards 

The final output is compared to user-specified water quality standards to assess the water quality 
in the area.  The pollutant name and threshold concentration are input to create a standard, which 
can be stored in a group with standards for other pollutants or alone.   

Use the Water Quality Standards dialog box to view and edit all previously defined water quality 
standards.  Use the options menu to create, delete, copy, import, or export water quality 
standards. 
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Modify Water Quality Standard 

Water quality standards can be modified in two ways within N-SPECT:   

1. To modify an existing water quality standard, select Advanced Settings and Pollutants.  
Select the pollutant of interest in the Pollutant Name drop-down list.  The list will display all 
the currently defined pollutants within N-SPECT.  Fields in the Pollutants window are 
populated according to the selected pollutant.  The Water Quality Standards tab is 
automatically populated with any standards, their descriptions, and threshold values already 
defined for the selected pollutant.  The user will be able to view or modify the threshold for 
the pollutant in this window. 
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Name: The Name column on the Water Quality Standards tab is automatically populated with all 
currently defined water quality criteria for the selected pollutant.  This field cannot be edited. 

Description: The Description column on the Water Quality Standards tab is automatically 
populated with all currently defined water quality criteria for the selected pollutant.  This field 
cannot be edited. 

Threshold: The Threshold column on the Water Quality Standards tab is automatically populated 
with the values assigned to each water quality criteria for the selected pollutant.  Threshold 
values are in units of micrograms per liter.  If no value has been assigned, the field will be empty.  
New values can be entered or existing values can be modified in this window. 

2. To modify an existing water quality standard, select Advanced Settings and Water Quality 
Standards.  The Water Quality Standards window is automatically populated with any 
standards, their descriptions, and threshold values already defined for each pollutant.  The 
user is able to view or modify the threshold for the pollutant in this window.  Once the 
threshold numbers are modified, the new values will be saved.  
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Add New Water Quality Standard 

A new water quality standard can be created in two ways within N-SPECT: 

• In the Run Analysis project window, use the Water Quality Standard drop-down menu to 
select New water quality standard.  All the defined water quality standards will be listed in 
this drop-down menu, but the last entry in the list will give the option to create a new 
water quality standard.   

• Select Water Quality Standards under Advanced Settings and select New from the 
Options menu.  Either one of these options will take you to the Add Water Quality 
Standard dialog box.   
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Standard Name: Provide a name for the new water quality standard being added (limit of 35 
characters). 

Description: Provide a brief description (less than 100 characters) of the new water quality 
standard. 

Pollutant: This field is automatically populated with all currently defined pollutants.  This field 
cannot be edited.  

Threshold: Provide a threshold value for each pollutant for the new water quality standard.  The 
values should be entered in microgram per liter (ug/l). 

Click Save to add the new standard to the database and the Standard Name drop-down menu.  

 

Delete Water Quality Standard 

To delete an existing water quality standard, select the desired water quality standard for deletion 
in the Standard Name field and select Delete from the Options menu.  Confirm the choice to 
delete and the selected water quality standard will be deleted from the database. 

 

Copy Water Quality Standard 

To copy a water quality standard, select Copy from the Options menu.  Designate a standard 
name from which to copy and a new standard name.  The Copy from Standard Name drop-down 
menu will contain all currently defined water quality standards.  Click OK to create a new water 
quality standard that is identical to the water quality standard selected in the Copy from Standard 
Name field.  The new water quality standard can then be edited and saved. 
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Import Water Quality Standard 

To import a water quality standard, select Import from the Options menu.  Specify a name for the 
water quality standard to be imported.  Browse for the water quality standard file that contains the 
values to be imported.  The imported file must be an ASCII file containing a header row, followed 
by a row of comma-separated values for each pollutant.  The header row should contain the 
name of the water quality standard and a description, separated by a comma (no space).  Each 
row must contain two fields ordered as follows: pollutant,threshold.  The new standard will be 
added to the Standard Name drop-down list. 

 

Export Water Quality Standard 

To export a water quality standard, select Export from the Options menu.  Name the file and 
designate a location in which to save it.  The water quality standard will be written to a comma-
separated ASCII file containing a row of values for each pollutant.  The file will contain a header 
row with the name of the water quality standard and the description.  Each row will contain two 
fields ordered as follows: pollutant,threshold. 
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3.5 Precipitation Scenarios 

The intensity, length of precipitation event, and amount of precipitation that falls during an event 
has a large impact on the amount of erosion that occurs during the rainfall.  Erosion is calculated 
differently using annual precipitation data than it is using event-specific data.  The Revised 
Universal Soil Loss Equation (RUSLE) is used to calculate average annual erosion with annual 
precipitation data, while the Modified Universal Soil Loss Equation (MUSLE) is used to calculate 
erosion from specific events and requires event-specific rainfall data. 

A precipitation scenario must be specified to calculate runoff within N-SPECT.  The precipitation 
scenarios that are defined within N-SPECT can be modified or new scenarios can be created.  N-
SPECT also provides the ability to delete precipitation scenarios. 

 

 

Modify Precipitation Scenario 

To modify an existing precipitation scenario, select Advanced Settings, Precipitation Scenarios.  
Fields in the Precipitation Scenarios window are populated according to the selected scenario. 

Scenario Name: This field contains a drop-down list of all the currently defined precipitation 
scenarios.  Fields in the Precipitation Scenarios window are populated according to the selected 
Scenario Name.  This field cannot be edited. 

Description: This box provides a brief description of the selected precipitation scenario.  The 
description for the precipitation scenario can be modified and saved. 

Precipitation Grid: The precipitation grid contains spatial values for precipitation over the area of 
interest.  The name and path of the precipitation grid are displayed.  To change the precipitation 
grid associated with the scenario, use the browse button to select a precipitation grid for your 
analysis and choose Add. 

Grid Units: This field defines the cell size units (meters or feet) of the specified precipitation grid. 
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Precipitation Units: This box defines the precipitation units (centimeters or inches) used in the 
precipitation grid. 

Time Period: This field specifies the type of precipitation scenario—annual or event—depending 
on the precipitation data set that is being used.  Annual precipitation events will use different 
methodologies for estimating soil erosion than event-based precipitation events.   

The annual and event types of precipitation scenarios for Wai’anae were developed in 
conjunction with the Hawai’i state climatologist.  See the N-SPECT technical guide for specific 
details. 

Raining Days:  This number indicates the average number of storms that occur in a one-year 
period in the area of interest. 

Type: This field specifies the rainfall type in the analysis region.  The different rainfall types 
describe the four synthetic 24-hour rainfall distributions developed by the Natural Resources 
Conservation Service (NRCS).  The National Weather Service’s duration-frequency data or local 
storm data were used to develop these distributions.  All of Hawai’i is Type I rainfall (see following 
table for descriptions of rainfall types). 

NRCS Rainfall Distributions 

Type Description 

Types I and IA Pacific maritime climates with wet winters and dry summers.  Type IA is the 
least intense rainfall.  

Type II  Most of the country falls into this category.  Type II is the most intense short 
duration rainfall. 

Type III Atlantic coastal areas and the Gulf of Mexico where tropical storms with large 
24-hour rainstorms occur. 

 

New Precipitation Scenario 

A new precipitation scenario can be created in one of two ways:  

• In the Run Analysis project window, use the Precipitation Scenario drop-down menu to 
select New precipitation scenario.  All the defined precipitation scenarios will be listed in 
this drop-down menu, but the last entry in the list will give the option to create a new 
precipitation scenario.   

• Select Precipitation Scenarios under Advanced Settings and select New from the Options 
menu.  Either one of these options will take you to the New Precipitation Scenario dialog 
box.   
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Scenario Name: Provide a name for the new precipitation scenario being added (limit of 35 
characters). 

Description: Provide a brief description (less than 100 characters) of the new precipitation 
scenario. 

Precipitation Grid: Use the browse button to select the precipitation grid to associate with this 
precipitation scenario. 

Grid Units: Specify the cell size units (meters or feet) of the specified precipitation grid.  This 
information may be found in the metadata for the precipitation data set. 

Precipitation Units: Specify the precipitation units (centimeters or inches) that are reported in 
the precipitation grid.  This information may be found in the metadata for the precipitation data 
set. 

Time Period: Specify the type of precipitation scenario, annual or event, depending on the type 
of precipitation data you are using.  Different methodologies will be used to estimate soil erosion 
from annual precipitation data than from event -based precipitation data.  To avoid confusion, your 
scenario name should accurately reflect the time period you have chosen. 

Type: Specify the rainfall type in the analysis region.  The different rainfall types describe the four 
synthetic 24-hour rainfall distributions developed by the Natural Resources Conservation Service 
(NRCS).  The National Weather Service’s duration-frequency data or local storm data were used 
to develop these distributions.  All of Hawai’i is Type I rainfall. 

 

Delete Precipitation Scenario  

To delete an existing precipitation scenario, select the desired precipitation scenario for deletion 
in the Scenario Name field and select Delete from the Options menu.  Confirm the choice to 
delete when prompted and the selected precipitation scenario will be deleted from the database. 
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3.6 Watershed Delineations  

Watersheds are a common and logical analysis unit for conducting water quality assessments.  
The first step in creating a vector layer of watershed polygons is to load a digital elevation model 
(DEM).  N-SPECT incorporates functionality similar to that found in the Arc Hydro Tools® 
extension.  A flow direction grid, flow accumulation grid, vector watersheds layer, and length-
slope (LS) factor grid are all generated when a new watershed delineation is created. 

The watershed delineations that are already defined within N-SPECT are listed in the Watershed 
Delineation Name drop-down list in the Watershed Delineations window.  Fields in the Watershed 
Delineations window are populated according to the selected watershed delineation name.  N-
SPECT provides the ability to create a new watershed delineation or delete a watershed 
delineation. 

 

Watershed Delineation Name: This field contains all the currently defined watershed 
delineations within N-SPECT.  Fields in the Watershed Delineations window are populated 
according to the selected watershed delineation name. 

DEM Grid: The DEM Grid field provides topography data for use in N-SPECT analyses and is 
automatically populated with the DEM grid defined for the selected watershed delineation.  This 
field cannot be edited.  The tool was developed and tested using 30-meter DEMs from the U.S. 
Geological Survey (USGS), although other DEMs may also be used.  USGS digital elevation 
models are available for download at 

http://data.geocomm.com/dem/demdownload.html 

Note: Care must be taken to ensure the grid cells of the DEM and land cover data sets (and all 
other grid data sets) match.  This can be accomplished by setting the Snap extent to feature of 
the ArcGIS Spatial Analyst options menu to the DEM data set.  See the N-SPECT technical guide 
for more information. 

Units: This field is automatically populated with the DEM grid units (meters or feet) defined for 
the selected watershed delineation.  This field cannot be edited in this window. 
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Hydrologically Corrected DEM: Select the Hydrologically Corrected DEM check box if you have 
already hydrologically corrected the DEM by filling sinks.  If this check box is cleared, N-SPECT 
will automatically perform this hydrological correction process before creating the watershed 
delineation.  

Subwatershed Size: Subwatershed size designates the subwatershed size (small, medium, or 
large) for the selected watershed delineation.  The subwatershed size is relative to the DEM; a 
small subwatershed is 0.1 percent of the maximum flow accumulation value, a medium 
subwatershed is 1 percent of the maximum flow accumulation value, and a large subwatershed is 
10 percent of the maximum flow accumulation value.  This field cannot be edited in this window. 

Watershed: This field displays the watershed file that was created in the watershed delineation 
process. 

Flow Accumulation Grid: This field displays the accumulation grid that was created when the 
selected watershed delineation was created.  Each cell in the flow accumulation grid contains the 
total value of all cells upstream of that cell. 
 
LS Grid: The LS Grid is the length-slope grid that is used in calculating erosion.  Length-slope is 
a parameter needed to use the MUSLE equation to estimate soil loss from a short-term rain 
event. 

 

Add New Watershed Delineation 

A new watershed delineation can be created in one of two ways: 

• In the Run Analysis project window, use the Watershed Delineation drop-down menu to 
select New watershed delineation.  All the defined watershed delineations will be listed in 
this drop-down menu, but the last entry in the list will give the option to create a new 
watershed delineation.   

• Select Watershed Delineations under Advanced Settings and select New from the 
Options menu.  Either one of these options will take you to the New Watershed 
Delineation dialog box.   
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Watershed Delineation Name: Provide a name for the new watershed delineation being added 
(limit of 35 characters). 

DEM Grid: Browse to the DEM Grid that will be used for the analysis in the area of interest. 

Units: Specify the DEM grid units (meters or feet) for the selected DEM. 

DEM is hydrologically correct (filled): Check the DEM is hydrologically corrected box if the 
DEM has already been hydrologically corrected by filling sinks.  If this check box is cleared, N-
SPECT will automatically perform this hydrological correction process before running the 
analysis.  

Subwatershed Size: Select the subwatershed size to indicate the approximate subwatershed 
size (small, medium, or large) for the selected watershed delineation.  The subwatershed size is 
relative to the DEM; a small subwatershed is 0.1 percent of the maximum flow accumulation 
value, a medium subwatershed is 1 percent of the maximum flow accumulation value, and a large 
subwatershed is 10 percent of the maximum flow accumulation value.   

Note: This field cannot be edited in this window. 

Click OK to derive the new watershed delineation and process all associated files. 

  

Delete a Watershed Delineation 

To delete an existing watershed delineation, select the desired watershed delineation for deletion 
in the Delineation Name field and select Delete from the Options menu.  Confirm the choice to 
delete when prompted and the selected watershed delineation will be deleted from the database. 

 

3.7 Soils 

Soils data are used to estimate sediment loads using the NRCS-developed RUSLE and MUSLE 
equations.  RUSLE is used to estimate average erosion over time, whereas MUSLE is used to 
estimate erosion from specific rainfall events.  N-SPECT was developed using soils data from the 
SSURGO database; however, any land soils data can be used in the tool provided the data are in 
the appropriate format.  The soils configurations that are defined within N-SPECT are listed in the 
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Name drop-down list in the Soils window.  Fields in the Soils window are populated according to 
the selected soil name.  N-SPECT provides the ability to create a new soils configuration or 
delete a soils configuration. 

 

 

 

Add New Soils Configuration 

To define a new soils data set, select Advanced Settings and then Soils, and select New from the 
Options menu.   
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Name: Provide a name for the new soils configuration being added (limit of 35 characters). 

DEM Grid: Browse to specify the DEM Grid that you are using in the analysis area.  This should 
match the DEM grid used in the watershed delineation process.   

Soils Data Set: Select the soils data set (polygon layer) that contains soils information for the 
area of interest.  The soils data currently provided in N-SPECT were acquired from the U.S. 
Department of Agriculture (USDA) NRCS SSURGO database.  Although these data are available 
for download on the Web, a few modifications are necessary before they can be loaded into N-
SPECT.  See the N-SPECT technical guide for information on processing the soils data. 
 
Hydrologic Soil Group Attribute: Select the attribute in the soils data set that corresponds to 
the hydrologic soil group information.  The hydrologic group (hydgrp) is an attribute found in the 
comp table of the SSURGO database.  The hydrologic group is assigned based on soil infiltration 
rates.  These are grouped into four categories, A through D, based on decreasing infiltration (A = 
high infiltration, D = very slow infiltration).  
 
Hydrologic Soil Group Definitions 

Hydrologic Soil 

Group 
Soil Group Characteristics 

A 
Soils having high infiltration rates, even when thoroughly wetted and 
consisting chiefly of deep, well- to excessively drained sands or 
gravels.  These soils have a high rate of water transmission. 

B 

Soils having moderate infiltration rates when thoroughly wetted and 
consisting chiefly of moderately deep to deep, and moderately fine to 
moderately coarse textures.  These soils have a moderate rate of 
water transmission. 
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C 

Soils having slow infiltration rates when thoroughly wetted and 
consisting chiefly of soils with a layer that impedes downward 
movement of water, or soils with moderately fine to fine texture.  
These soils have a slow rate of water transmission. 

D 

Soils having very slow infiltration rates when thoroughly wetted and 
consisting chiefly of clay soils with a high swelling potential, soils with 
a permanent high water table, soils with a claypan or clay layer at or 
near the surface, and shallow soils over nearly impervious material.  
These soils have a very slow rate of water transmission. 

 
K Factor Attribute: Select the attribute in the soils data set that corresponds to the K factor.  The 
K factor (kffact) is an attribute found in the layer table of the SSURGO database.  This factor is 
derived from the amount of soil lost per unit of erosive energy in the rainfall, assuming a standard 
research plot.  It is an erodibility factor that quantifies the susceptibility of soil particles to 
detachment and movement by water.  The K factor is used in RUSLE and MUSLE to calculate 
soil loss by water.  The two most important factors related to soil erodibility are infiltration capacity 
and structural stability.  Low infiltration capacity would cause more surface runoff, and the surface 
is less likely to be ponded, making soil more susceptible to splashing.  Some properties that 
create a high K factor value are high contents of silt and clay, or impervious soil layers.  Areas 
without a K factor value (disturbed soils) will be assumed to carry a K value of 0.30. 

Advanced MUSLE Specific Parameters: MUSLE requires two constants that can be locally 
calibrated to estimate event -based erosion.  In the Advanced MUSLE Specific Parameters 
section, the universal MUSLE equation is given under “MUSLE Equation for sediment yield.”  The 
user can enter locally specific constants into the text boxes under “Locally calibrated MUSLE 
equation for sediment yield currently being used by N-SPECT.”  The default values are local 
constants for the Wai'anae area on O'ahu, Hawai’i. 

 

Delete Soils Configuration 

To delete an existing soils data set, select the desired soils data set for deletion in the Name field 
and select Delete from the Options menu.  Confirm the choice to delete when prompted and the 
selected soils data set will be deleted from the database.
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4. Output  
Output data sets are organized and displayed in the ArcMap table of contents using group layers.  
Data sets that result from running an N-SPECT analysis for accumulated effects will include 
 

• Accumulated runoff volume grid (liters).  This grid displays accumulated values of water 
volume at each cell in the analysis area.  These values are used in calculating the 
pollutant and sediment concentration grids by dividing the pollutant/sediment 
accumulation grid by the water volume to give a concentration.  

• Accumulated pollutant grid (kilograms).  This grid displays the accumulated load of the 
specified pollutant at each cell in the analysis area. 

• Pollutant concentration grid (milligram per liter).  Each cell in this grid gives an estimate of 
the concentration of the specific pollutant at that location.  The user can easily identify 
specific areas of concern that may be logical targets for further monitoring.   

• Pollutant assessment grid (milligrams per liter).  Pollutant concentration grids are 
compared with user-specified water quality standards and a pollutant assessment grid is 
created for each pollutant.  This grid shows how the estimated pollutant concentration 
compares with the selected water quality standard in the receiving waters.   

• Accumulated sediment load grid (kilograms).  A total sediment load grid is created for 
each N-SPECT run for which the user chooses to calculate erosion. 

• Sediment concentration grid (kilograms per liter).  Each cell in this grid gives an estimate 
of the concentration of sediment at that location.  The user can easily identify specific 
areas of concern that may be logical targets for further monitoring. 

 
Data sets that result from running an N-SPECT analysis for local effects will include 

• Local runoff grid (liters).  This grid displays the volume of runoff from each cell in the 
analysis area. 

• Local pollutant grid (milligrams).  This grid displays the source areas of the specified 
pollutant at each cell in the analysis area. 

• Local sediment load grid (milligrams).  This grid displays the source areas of sediment 
load for each N-SPECT run for which the user chooses to calculate erosion. 

 
Metadata 
 
Each data set that is delivered with N-SPECT has a metadata file associated with it that can be 
viewed with ESRI’s ArcCatalog.  The same is true for each output data set that is created with N-
SPECT.  Each time a new analysis is completed, metadata is created for each output data set, 
which includes information such as the N-SPECT project the output file is associated with and the 
parameters that were chosen to run the tool when the data set was created 
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5. Hints and Acronyms 
Right -clicking within the tables contained in the N-SPECT window will allow you to append a row 
(add blank row at the end of the grid), insert a row (insert a blank row above the current row), or 
delete a row from the table. 
 

ASCII: American Standard Code for Information Interchange 

C-CAP: Coastal Change Analysis Program 

DEM: Digital Elevation Model 

MUSLE: Modified Universal Soil Loss Equation 

NRCS: Natural Resources Conservation Service 

N-SPECT: Nonpoint Source Pollution and Erosion Comparison Tool 

NWS: National Weather Service 

RUSLE: Revised Universal Soil Loss Equation 

SCS Curve Number: Soil Conservation Service Curve Number 

SSURGO Database: Soil Survey Geographic database 

USDA: United States Department of Agriculture 

USGS: United States Geological Survey 

 



 

                                                                    

 


